Working with Excel

Quick Tips for formatting
files and creating reports
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Converting a spreadsheet to a table
Adding a “Total” row

Coding in the count formula
Freezing rows and columns
Filtering Excel tables

Clearing filters

Sorting columns

10 Custom sorting

11. Clearing columns and rows

12. Clearing CE ID column
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To manipulate data for better analysis and reporting

Click any cell within the
spreadsheet

Click on the Insert tab
Click on Table to open a
dialogue window. Excel
automatically selects all
cells for the table,

stopping at the first blank

column and row.

Make sure My table has

headers is checked.
Click OK
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E4 % 350-8210 Et Road Leeannsville, Texas 79123-4567
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Meal Code F or RP
Last First Program Derived from

1] Name Name Address Gender CEID Site ID Program value. EDG # Eligibility Date
2 Acevedo Kerry Ap #469-9: F 0999s  ‘poo1 TANF F 091872939 8/1/2017
3 Blake  Abraham 5887 Nibh. M 9939 ool sNap F ‘020284939 8/1/2017
Il Callahan Cole 50-8210 E.M SNAP :021584399 8/1/2017
5 | Cardenas Hillary Ap #219-4F 060815999 8/1/2017
6 | Christenst Judah 686-795 Pr M ‘091497899 8/1/2017
7| Davenpor Deacon P.0O.Box4 M "091526999 8/1/2017
s Day Oren P.0.Box1M "082612499 8/1/2017
s Fields  Tucker Ap #974-4(M "062342399 8/1/2017
10| Harvey  Darryl 433-4671CM "060632999 8/1/2017
11| Hyde Aubrey 8545 NonuF ‘030345499 8/1/2017
12 Lewis Pascale Ap #266-6¢/M ’041765699 8/1/2017
13 Marshall Tad Ap #350-3IM ’011549099 8/1/2017
14 Noble Ignacia 3146 Dolar F ‘030792399 8/1/2017
15 | Pratt Dolan P.0.Box 1M 123036999 8/1/2017
16 | Serrano  Lee Ap #168-1i M "032871099 8/1/2017
7 Snider  Kermit Ap #458-7(M "072265499 8/1/2017
18 Walker  Quynn 7194 Inter(F "071523699 8/1/2017
19 Alford Erica 759-8803 hF 09999 0041 C F '112838099 8/1/2017
20 | Ayers Alden 864-7666 CM 09999 ’0041 C F ’121114299 8/1/2017
21| Barker Hiram 106 Incept M 09999 ’0041 C RP ’010323499 8/1/2017
22 Bryan  Eaton 5452 Lacus M Togss  ooal ¢ F :031255599 8/1/2017




Creating a “total” row to add all numbers within columns or a column

Table Name: [i] Summarize with PivotTable [ [=] Properties Header Row__ || First Column Filter Button e e e .
=22 [ LA Fitter Button, B s mmm mees =====
Tablel [-f Remove Duplicates | Eeon Refrh [ Open in Browser | [] TotalRow | (] Last Column = | S | e e =]
< nsert port Refres| EEEEE E==EsIE=EmE=m=s E==== == === -
3 Resize Table | B Convert to Range Sicer | - - G2 Unlink Banded Rows | | Banded Columns ! 1L ] —
Properties Tool External Table Data Table Style Options Table Styles
114 2 & |l c

Program
Bl Aidress B ciender B i = claimed and Certifiable B B Meal code F or RP Derived from Program valu::. Bl )G #
2 |16880801-1608 Acevedo  Kerry b #469-92 1 B —F 091872999
3 |16650413-9749 Blake Abraham '03/28/03 8387 Nibh. St. LM T T '020284999
4 190380224003 ~oUsiae. Artin "alp3dre. EACBUNED 2 K T oa0rGra5s
=.j|m;a| 32 32

To add a “total” row:

With the entire table selected, go to the Table Tools tab

* To select entire table, click the *select all button
In the Table Style Options category:

* Check the Filter button box
 Check the box for Total Row



To get total number of entries in a number field with a range of numbers

It is important to change the columns listed here to make reporting those numbers easier.

4| Unique Student ID |~ |Last Name  ~|First Name [~]DoB [~|Address [~ | Gender [~]cEID [~ Site ID ~| C = Claimed and Certifiable [~| Program ~| Meal Code F or RP Derived from Program value. |~ |EDG # |~ | Eligibility Date |~
48 |16961209-8385 Leblanc Ursa ‘02/18/12 Ap #853-89720 F ‘09993 ‘o101 c Medicaid-F |F 022696199 8/1/2017
49 16590721-6336 Lloyd Yvette '111'15/03 602-3332 Ac, AVF ‘09939 ‘o101 C SNAP F 061259199 8/1/2017
50 |16040129-7239 Mccullough  Yvonne ‘0s/0a/03 6586 Posuere, SF ‘09993 0101 c TANF F 112139999 8/1/2017
51 |16700310-9302 Mejia Bevis '08/31/10 P.0.Box 919, 47M ‘09999 ‘o101 c Medicaid-F | F 011879299 8/1/2017
52 |16421225-8042 Moreno Lucas '05/11/08 Ap #886-565 Du M ‘09999 ‘0101 < Medicaid-F |F 120274799 8/1/2017
53 |16690723-3511 Peck MacKenzie  03/07/07 914-9236 Quisq! F ‘09393 ‘o101 c SNAP F 120917099 8/1/2017
54 |16731220-4592 Reese Veronica ‘0a/10/12 Ap #896-9418 Ls F ‘09999 ‘0101 c SNAP F 051716699 8/1/2017
55 |16501115-8309 Reyes Ivor "11/02/10 1972 Fusce Roa(M ‘9993 ‘o101 c Medicaid -RP | RP 010466599 8/1/2017
56 3250 bi Flynn '02/21/08 P.0. Box 960, 12M ‘09939 0101 c SNAP F 070208499 81/2017
57 7687 Saunders Quinn "12/23/10 6057 Lectus St. |M ‘o993 ‘o101 c SNAP F 082569899 8/1/2017
58 |16480227-1033 Shepherd Hayley ‘09/19/08 Ap #158-4312 S¢F ‘09999 ‘0101 c SNAP F 120753699 8/1/2017
59 |16420221-5068 Simpson Breanna ‘02/17/12 P.0. Box 636, 31F ‘933 ‘o101 c Medicaid-F | F 122745599 8/1/2017
60 |16690523-5906 Steph! Vladimir "10/05/10 Ap #910-2921 Di M ‘09999 0101 c Medicaid -RP | RP' 040911299 8/1/2017
61 |16610505-9056 Suarez Phelan ‘09/12/06 P.0.Box 234, 84M ‘09999 ‘0101 c SNAP F 042876799 8/1/2017
62 |16880224-6044 Vasquez Imani ‘07/21/12 P.0. Box 296, 21F ‘0993 ‘0101 c SNAP F 030767499 8/1/2017
63 |16570304-1243 Whitehead  Aladdin ‘0a/26/12 P.0. Box 852, 41M ‘09393 ‘0101 c TANF F 042398599 8/1/2017
64 116050711-0195 Zamora Ignacia ‘03/22/08 Ap #155-6681 St F ‘09993 ‘0101 c Medicaid -RP_| RP' 090597399 8/1/2017
85| Total | | 63,
66 None
el
&)
69 | Kin

Sum

) StdDev
il Var
= More Function

To change Last Name, Site ID, Program and Meal Code formulas:
* Select a cell on the last row of the Last Name column
* Click the filter arrow that appears to the right
* Select Count
* Repeat this for the Site ID, Program and Meal Code columns



Freezing the top row or first column to see them while scrolling
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Freeze Panes
Keep rows and columns visible while the rest of
the worksheet scrolls (based on current selection).
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Zoom

Freeze First Column

Keep the first column visible while screlling
through the rest of the worksheet. —

Acevedo Kerry 02/09/0 Ap #469-9279 Ip F 09999 0001

3 0016650413

DINAE T

Blake Abraham  03/28/08887 Nibh. St. LM ‘09999 ooo1

Freezing the top row or first column

To freeze top row, select the row directly below the row(s) you want to freeze
To freeze first column, select the cell immediately to the right of the column

you want to freeze

Go to the View tab
Select the Freeze Panes command and choose Freeze Top Row or Freeze First

Column



Filtering an Excel Table to display only certain information

C = Claimed and Certifiable |~ | Pron

r_l

E‘Neal(:n

_C %] SotAtez

€127 sprnZtoh
Sort by Color

¥ Clear Filter From "Program "
Filter by Color

Text Filters

o

olalo]ofalelo]o

earch
W] (Select Al
-] Medicaid - F

-RP

-] SHAP
|| TANF

!
| ||n|n$
| o |

0| ok | cancel

-

m

Bl

-

-

-

m

B

-

-

-

For example:
If you want to sort by SNAP program:
1. Click on the filter button on the
Program column
2. Click Select All box to remove
the check mark
3. Click on SNAP to check mark it
4. Click OK
The “Total” row now shows the number
of SNAP students. You can also sort by
multiple criteria by selecting and filtering
the desired categories.



Removing one or all filters will return your spreadsheet to its original display

To clear all filters at once:
e Click the Data tab E

View Developer ACROBAT DNesian

eview
|7|Tb, L] Connections
P z
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e Layout
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To clear one filter: T e
* Click on the filter button for Foran R .
the desired column B s .
* Select Clear Filter From (name e

of column).




Sorting to reorder your data into groups

2l SotAtez | . o
T sanzo Sorting Alphabetically:
R —— 1. Click on Filter Button at the top of the desired

Filter by Color

e Ete » column
s = 2. Select Sort option (Ato Zor Z to A)
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Custom sorting:
1. Click on Home tab
2. Select Sort and Filter (on the right)
3. Click on Custom Sort



Examples of custom sorting by multiple criteria

*a| Add Level || < Delete Level H R Copy Level ||

4
3 dd Level || xgelete Level || E@ Copy Level ” Fs IZ| My data has headers

| 2| Add Level H 7% Delete Level || R Copy Level H a Column Sort On Order

Cotumn sorton Column Sort On Sortby | site D [v] |values Iv] |atoz Iv]
Sortby | program ﬂ Values Sort by “s'rteID | |\Jalues Then by |pmgram E| |Va|ues E| |At02 E|
Then by [site 1D @ Values Then by _ IE Then by |LastName |z|| |Va|ues |z|| |At02 |z||

To sort students grouped by program and then site, start with program.

To sort a group by the program at each site, then start with the site and then

add program.

To sort students alphabetically by program at each site, then start with site,

add program, then last name.
* Select Values in the Sort On section when sorting data
* Select how you want it ordered (A to Z, Z-A, or custom)




Spreadsheets may contain invisible data that causes uploading problems. Clearing this type of

Invisible Data May be Causing Upload Errors

data is a good practice to maintain.

Clearing a column:

d A [ | o | E G G H 1 [ |
[5| 123-45-6789 0016234567 Doe Jane 12/12/1900 F 0001 12 09999
[ 6] 123-45-6789 0016234567 Doe Jane 12/12/1900 F 0001 09 09999
[ 7| 001-23-2567 0016234567 Doe Bob 12/12/1900 ™ [ 09 na9aa
[ 8] 123456789 0016234567 Doe Bob 12/12/1900 53 copy
[ 001-23-2567 0016234567 Doe Bob 12/12/1300 | (%, Paste Options:

[10| 123-45-6789 0016234567 Doe Jane 12/12/1900
[11] 123-45-6789 0016234567 Doe Bob 12/12/1900 =
[12| 001-23-2567 0016234567 Doe Jane 12/12/1900 Paste S

13| 123-45-6789 0016234567 Doe Jane 12/12/1900
|18| 123-5-6789 0016234567 Doe Bob 12/12/1900 Insert..
[15| 001-23-4567 0016234567 Doe Bob 12/12/1900 Delete...
[16| 123-25-6789 0016234567 Doe Jane 12/12/1900 Ciear Contents
[17| 123-45-6789 0016234567 Doe Bob 12/12/1900
[18| 001-23-4567 0016234567 Doe Jane 12/12/1900 Filter 4
[19] 123-45-6789 0016234567 Doe Jane 12/12/1900 Sart »

20|  001-23-4567 0016234567 Doe Jane 12/12/1900
[21] ' [Insert Comment
[22] %F Format Cells...
,2:3—~ S e Pick From Drop-d: List... il

Define Name,..
g Hyperlink..,
—

Click the letter of the column you want
to clear, this selects the entire column.
Press and hold Ctrl + Shift + Right

Arrow

Right-click highlighted cells and select
Clear Contents

Clearing

d row:

Click the number of the row you want

Define Name,..

g Hyperlink..,
e

| 4] A B [ E [ F G 1
|5 123-45-6789 0016234567 Doe Jane 12/12/1500 F 0001 12 09999
| 6 123-45-6789 0016234567 Doe Jane 12/12/1900 F 0001 09 09999
7| 001234567 0016234567 Doe Bob 2 copy 09 09999
|8 123-45-6789 0016234567 Doe Bob @ | pasts Options 10 09999
| 9 001-23-4567 0016234567 Doe Bob 11 09999
10 123-45-6789 0016234567 Doe Jane = 10 09999
11 123-45-6789 0016234567 Doe Bob Paste Spedial 11 09999
(12 001-23-4567 0016234567 Doe Jane -, 12 09999
13| 123-45-6789 0016234567 Doe Jane 11 09999
12 123456789 0016234567 Doe Bob Defetes 09 09999
15 001-23-4567 0016234567 Doe Bob FACOPCOMENIS 10 09999
16 123-45-6789 0016234567 Doe Jane Filter > 12 09999
(17 123-45-6789 0016234567 Doe Bob ca 5 09 09999
18 001-23-4567 0016234567 Doe Jane 11 09999
19| 123-45-6789 0016234567 Doe Jane & Insert Comment | 12 09999
20 001-23-4567 0016234567 Doe Jane A Format Cells... 10 09999
! Pick From Drop-down List... E

to clear, this selects the entire row.
Press and hold Ctr/ + Shift + Down

Arrow

Right-click highlighted cells and select
Clear Contents



Extraneous or invisible data in the CE ID column

This also can cause problems during the upload process. To potentially avoid such issues, it

is important to clear this column of invisible or nonessential data.

To clear CE ID column:

Click the cell after the last
complete row of data

Press Ctrl + Shift + Down Arrow
Right-click highlighted cells and
select Clear Contents
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